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Introduction

O 
ver the years, project management has evolved from a discipline that 
began with index cards and yarn to one that now uses sophisticated 

analyses, techniques, projections, reporting, and time and money tracking. 
Project management software brings functionality to project management 
that makes planning and tracking the complex projects we undertake a little 
more manageable.

About This Book
Microsoft Office Project 2016, the most recent incarnation of the world’s 
most popular project management software, offers a tremendous wealth 
of functionality to users. In the beginning, however, as with most software, 
mastering it can seem like a daunting process. It helps to understand how 
Project’s features relate to what you do every day as a project manager.

In Project 2016 For Dummies, my goal is to help you explore Project 2016, 
providing information on relevant project management concepts while also 
offering specific procedures to build and track a Project schedule. More 
important, I offer advice on how to make all these features and procedures 
mesh with what you already know as a project manager to ease the transition 
to using Project 2016.

Here are some broad topics that I help you explore in this book. You can

✓✓ Start out in Project 2016 by entering tasks and dependencies, estimating 
durations, and working with views

✓✓ Work with resources, calendars, and costs

✓✓ Negotiate constraints, fine‐tune the schedule, and set a baseline

✓✓ Gather data, analyze progress, take corrective actions, and report 
project status

Within this book, you may note that some web addresses break across two 
lines of text. If you’re reading this book in print and want to visit one of these 
web pages, simply key in the web address exactly as it’s noted in the text, 
pretending as though the line break doesn’t exist. If you’re reading this as 
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an e‐book, you’ve got it easy — just click the web address to be taken directly 
to the web page.

Foolish Assumptions
I’ve made some assumptions about you, gentle reader. I figure that you’re 
computer‐literate and that you know how to use the mouse, the keyboard, 
software menus, and toolbars. I assume that you know how to use most 
common Windows functions (such as the Clipboard), as well as many basic 
software functions, such as selecting text and dragging and dropping items 
with the mouse.

I also assume that you have experience in managing projects. Whether you 
manage very large projects that are several years long or you have been a 
team lead on a project, the information in this book is more accessible if you 
have a background in project management.

I do not assume that you’ve used Project or any other project management 
software. If you’re new to Project, you’ll find what you need to get up to 
speed, including information on how Project works, finding your way around 
the Project interface, and building your first Project plan. If you’ve used an 
earlier version of Project, you’ll find out about Project 2016 and all the new 
features it provides.

Icons Used in This Book
One picture is worth . . . well, you know. That’s why For Dummies books use 
icons to provide visual clues to what’s going on. Essentially, icons call your 
attention to bits of special information that may well make your life easier. 
The following icons are used in this book.

The Remember icon signals either a pertinent fact that relates to what you’re 
reading at the time (but is also mentioned elsewhere in the book) or a reit-
eration of a particularly important piece of information that’s, well, worth 
repeating.

Tips are the advice columns of computer books: They offer sage advice, a bit 
more information about topics under discussion that may be of interest, or 
ways to do things a bit more efficiently.
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Warning icons spell trouble with a capital T: When you see a warning, read 
it. If you’re not careful, you might do something at this point that could 
cause disaster.

Beyond the Book
In addition to the material in the print or e‐book you’re reading right now, 
this product also comes with some access‐anywhere goodies on the web:

✓✓ Cheat Sheet: The cheat sheet has lots of shortcuts and other nifty tips 
and tricks. You can find the Cheat Sheet at www.dummies.com/ 
cheatsheet/project2016.

✓✓ Web Extras: There is a web extra for every part in this book. Just follow 
the link to the Web Extras at www.dummies.com/extras/ 
project2016.

✓✓ Companion website: This book is accompanied by a companion website 
that includes a project charter example and template, as well as several 
sample forms to help you plan and manage the schedule. To access this 
additional material, point your web browser to www.dummies.com/go/
project2016fd.

Where to Go from Here
Take what you’ve learned in the project management school of hard knocks 
and jump into the world of Project 2016. When you do, you’ll be rewarded 
with a wealth of tools and information that help you manage your projects 
much more efficiently.

Your first step might be to read the table of contents and find the sections of 
this book that you need — or simply turn to Chapter 1 and start reading.

http://www.dummies.com/cheatsheet/project2016
http://www.dummies.com/cheatsheet/project2016
http://www.dummies.com/extras/project2016
http://www.dummies.com/extras/project2016
http://www.dummies.com/go/project2016fd
http://www.dummies.com/go/project2016fd
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for more great content online.

Part I
Getting Started with  

Project 2016
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In this part . . .
✓✓ Get familiar with the Ribbons and file tabs in Project 2016.

✓✓ See how to open a new project, enter tasks, and organize a 
project.

✓✓ Become skilled in working with summary tasks, milestones, and 
notes.

✓✓ Identify and arrange task dependencies to create a network 
diagram.

✓✓ Develop duration estimates for tasks.

✓✓ Customize Project views to meet your needs.



Chapter 1

Project Management, 
Project 2016, and You

In This Chapter
▶▶ Understanding the elements of a project

▶▶ Laying out the project manager’s role

▶▶ Benefitting from Project 2016

▶▶ Exploring the software interface

▶▶ Finding help in Project

W 
elcome to the world of computerized project management with 
Microsoft Project. If you’ve never used project management software, 

you’re entering a brave new world.

Everything you used to do with handwritten to‐do lists, word processors, 
and spreadsheets magically comes together in Project. However, this transi-
tion doesn’t come in a moment, and you need a basic understanding of what 
project management software can do to get you up to speed. If you’ve used 
previous versions of Project, the overview in this chapter can refresh your 
memory and ease you into a few of the new Project 2016 features.

Even if you’re a seasoned project manager, this chapter provides the founda-
tion for how to work with Project.

Introducing Project Management
You probably handle projects day in and day out. Some are obvious, because 
your boss named them so that any fool would know that they’re proj-
ects: Acme Drilling Project or Network Expansion IT Project, for example. 
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Others are less obvious, such as that presentation you need to put together 
for your director or that how‐to guide on planting a vegetable garden in 
your backyard.

In this book, a project is defined as a unique venture undertaken to produce 
distinct deliverables, products, or outcomes. In the context of a project, a 
deliverable is a discrete component or item that meets the requirements of 
the project, such as a design document or a prototype. Projects have mul-
tiple variables; some are straightforward to define, and others aren’t.

Using the information about variables in Table 1‐1, you can say that project 
management is the practice of organizing, managing, and controlling project 
variables to meet the project outcomes and mission.

Defining project manager
Although understanding the role (let alone the usefulness) of certain manag-
ers isn’t always easy, you can easily spot the value of a project manager:  

Table 1-1	 Project Variables
Variable Description
Defined
Scope The work needed to produce the deliverables, products, or out-

comes for the project.

Time The duration required to complete the project work.

Cost The funds required to complete the project.

Resources The people, equipment, material, supplies, and facilities needed to 
accomplish the project.

Undefined
Change The type, timing, number, and degree of modifications from a project 

baseline; can affect the project’s scope, time, cost, or resources.

Risk Uncertainty (associated with the scope, time, cost, resources, 
stakeholders, or environment) that can threaten the completion 
of any aspect of the project. Fortunately, risks can also present 
opportunities to accelerate the schedule or come in under budget.

Stakeholder A person who can affect, or who is affected by, the project, either 
positively or negatively.

Environment The location, culture, or organization in which the project occurs.
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This person creates the master plan for a project and ensures that it is imple-
mented successfully. Along the way, the project manager uses technical, 
business, and professional skills to manage the completion of tasks and keep 
the schedule on track.

A truly professional project manager may have a degree in project manage-
ment or a professional certification. For example, if you see the initials PMP 
beside a name, that person has been certified as a project management pro-
fessional by the Project Management Institute, the leading global organiza-
tion establishing project management standards and credentials, and offering 
educational and other types of resources in the field.

Identifying what a project manager does
A project manager isn’t always the highest authority in a project. Often, that 
role belongs to whoever manages the project manager — including, possibly, 
members of senior management. Rather, the project manager is the person 
who ensures that aspects of the project are integrated and assumes hands‐on 
responsibility for successes as well as failures.

In project management parlance, the person who champions (and funds) a 
project is the project sponsor. Although the project manager may work for 
the project sponsor, the project often also has a customer — outside the 
project manager’s own company or within it — for whom the end product 
is produced.

The project manager manages these essential pieces of a project:

✓✓ Scope: Define and organize all work that needs to be done in order to 
meet the project mission and create deliverables.

✓✓ Schedule: This element, which you create by working with Project, 
includes the estimated steps and associated timing involved in reaching 
the project goal.

✓✓ Resources: Assign resources and track their activities on the project as 
well as resolve resource conflicts and build consensus. This part of the 
job also involves managing nonhuman resources such as materials and 
equipment.

✓✓ Cost: Estimate project costs and apply those estimates across the sched-
ule to create a time‐phased budget.

✓✓ Communication: Notify appropriate stakeholders (everyone who has a 
legitimate stake in its success) of the project status.
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Creating a logical balance of the defined variables of scope, time, cost, and 
resources is at the core of a good project manager’s job throughout the 
life of a project. Managing a project requires overseeing all its variables to 
ensure that the project goals are accomplished on time, within the limits of 
the budget, and using the assigned resources while also addressing risks, 
managing change, and satisfying stakeholders. Sound easy? Maybe not. 
However, one thing is certain: Having software to help organize and structure 
the work makes managing the project less daunting. That’s where Project 
2016 can help.

Introducing Project 2016
Project 2016, which is a scheduling tool, helps you organize, manage, and 
control defined variables, as identified in the preceding section. Project can 
also help you manage the undefined variables as well. In this book, I show 
you how to use Project to organize and manage your work, create realistic 
schedules, and optimize your use of resources.

Take a moment to look at some of the wonderful ways in which Project can 
help you organize, manage, and control your project. Now that you have, or 
your company has, bought Project (and this book) and you’re investing your 
time to understand how to use it, you can enjoy these benefits:

✓✓ Use built‐in templates to get a head start on your project. Project 
templates are prebuilt plans for a typical business project, such as com-
mercial construction, an engineering project, a new product rollout, soft-
ware development, or an office move.

✓✓ Organize your project by phase, deliverable, geography, or any other 
method. The outline format allows you to progressively elaborate the 
information in greater granularity depending on how detailed you want 
your plan to be.

✓✓ Determine costs by your chosen method. Examples are time period, 
resource type, deliverable, or cost type.

✓✓ Organize resources by resource type. Level your resources to avoid 
overallocation, or determine the impact on the duration of a task based 
on a change in resources.

✓✓ Calculate costs and timing based on your input. You can quickly calcu-
late what‐if scenarios to solve resource conflicts, maintain costs within 
your budget, or meet a deliverable deadline.
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✓✓ Use views and reports with the click of a button. A wealth of informa-
tion is now available to you — and those you report to. You no longer 
have to manually build a report on total costs to date to meet a last‐
minute request from your boss.

✓✓ Manage complex algorithms (that you couldn’t even begin to figure 
out on your own) to complete such tasks as leveling resource assign-
ments to solve resource conflicts, filtering tasks by various criteria, 
modeling what‐if scenarios, and calculating the dollar value of work per-
formed to date.

No matter how cool the tool, you have to take the time to enter meaning-
ful data. Great software doesn’t ensure great outcomes; it only makes them 
easier to achieve.

Getting to Know You
The file you create in Project is a Project schedule model. It’s a model because 
it models what you think will happen given what you know at the time. 
However, for ease of reference, I just refer to it as a schedule. The schedule 
has a plethora of data about various aspects of your project as well as graphi-
cal representations of that information.

Some people refer to the project schedule as the project plan. In reality, the 
project plan contains the project schedule — plus information such as the 
budget, work breakdown structure, project life cycle, risk management plan, 
and many other ingredients necessary to effectively manage a project.

When you first open Project 2016, you see several options for starting a new 
project, as shown in Figure 1‐1.

You can open a blank project, create a new project from an existing project, 
or create a new project by importing information from Microsoft Excel or 
SharePoint. You can also take advantage of premade templates for common 
project types, such as these examples:

✓✓ Agile project management

✓✓ Software development

✓✓ New product launch

✓✓ Residential construction



12 Part I: Getting Started with Project 2016 �

If you don’t see the template you need, you can search for online templates 
by entering keywords in the search box at the top of the page. For purposes 
of this discussion, I assume that you’re starting with a new, blank project.

When you open a new project, you see the Quick Access toolbar, a few file 
tabs, the Ribbon, the Timeline, a pane with a sheet and a chart, and the 
status bar, as shown in Figure 1‐2.

In Figure 1‐2, you see Gantt Chart view. (I discuss views in Chapter 6.) For 
now, here’s an overview of the major elements in Project (refer to Figure 1‐2):

✓✓ Quick Access toolbar: The Quick Access toolbar, above and to the left of 
the Ribbon, is onscreen at all times and in all views.

✓✓ File tab: The file tabs organize commands based on a particular type of 
activity. For example, if you’re working with resources, you’ll likely find 
the command or setting you want on the Resource tab.

✓✓ Ribbon: The Ribbon provides easy access to the most commonly used 
tools and commands. When you change tabs, the available tools on the 
Ribbon change.

✓✓ Group: A group is a set of related commands or choices on the Ribbon. 
For example, to format text in a cell on the sheet, first find the formatting 
information you need in the Font group on the Task tab of the Ribbon.

Figure 1-1:  
What you 
see when 
you open 

Project 
2016.
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✓✓ Timeline: The Timeline provides an overview of the entire project — a 
graphical view of the project from start to finish. You have the option of 
showing the Timeline or hiding it.

✓✓ Sheet: Similar to a spreadsheet, the sheet displays the data in the proj-
ect. The default fields change depending on the file tab you’re work-
ing in. You can customize the columns and fields in the sheet to meet 
your needs.

✓✓ Chart: The chart is a graphical depiction of the information on the sheet. 
Depending on the view or file tab you see, you might also see a bar 
chart depicting the duration of a task or a resource histogram showing 
resource usage.

✓✓ Status bar: The status bar, at the bottom of the Project window, has 
information on views and zoom level on the right, and information on 
how newly entered tasks are scheduled on the left.

Quick Access Toolbar TimelineTool Group

Status BarSheet Chart

Figure 1-2:  
A blank 
project.



14 Part I: Getting Started with Project 2016 �

Navigating file tabs and the Ribbon
Each of the seven file tabs in Project shows different options on the Ribbon. 
In this section, I provide an overview of each file tab and of the Ribbon and 
the Quick Access toolbar. I elaborate on various functions and commands on 
the Ribbon in later chapters.

The first tab on the left, the File tab, stands out in bright green. After you 
click this tab, you see the menu bar down the left side, as shown in Figure 1‐3.

The File tab puts you into Backstage view, where you find choices for work-
ing with files and changing options. For example, you can create a new proj-
ect, open an existing project, save your current project, or print your current 
project. From Backstage view, you can also share, export, or close your 
current project. If you’re feeling adventurous, you can even customize the 
Ribbon and the Quick Access toolbar.

The Task file tab is where you spend a lot of your time in Project. As you 
can see in Figure 1‐4, on the far left side of the Task file tab is the View. The 
default view is Gantt Chart view. It shows the task information and the chart 
that displays a bar chart representing the duration of each task.

Figure 1-3:  
The File tab 

menu.

Figure 1-4:  
The Task file 

tab.
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In addition to Gantt Chart, you can choose these views:

Calendar Network Diagram
Resource Sheet Resource Usage
Resource Form Resource Graph
Task Usage Task Form
Task Sheet Team Planner
Timeline Tracking Gantt

You may recognize some of the groups of commands on the Task file tab. 
For example, the Clipboard and Font groups are standard in many Windows 
applications. Other groups, such as Schedule and Tasks, are specific to a par-
ticular view — in this case, Gantt Chart view. Look for the deep green Gantt 
Chart Tools Format tab when you see the Task file tab in Gantt Chart view. In 
other views, you see different tools above the Format tab.

The Resource file tab, shown in Figure 1‐5, helps you organize resources, 
such as adding, assigning, and leveling resources across tasks. In Project, 
resources include people, equipment, material, locations, and supplies. You 
can assign costs and calendars to resources. (I talk more about resources in 
Chapter 7.)

The Report file tab, shown in Figure 1‐6, is new in Project 2016. You can 
create reports on resources, costs, or progress, or put them all together in a 
dashboard report. You can create a report that compares your current status 
to previous versions of your project. I tell you all about reports, including 
how to customize and export your reports, in Chapter 18.

Figure 1-5:  
The 

Resource 
file tab.

Figure 1-6:  
The Report 

file tab.
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On the Project file tab, you find commands to help you manage your project 
as a whole, rather than by task or resource. For example, you can enter or 
change the project start and finish dates and the baseline. If you need to 
change working time or add a subproject, this is the place to do it. Figure 1‐7 
shows the Project file tab.

The View file tab lets you see some standard views. Examples are Task views, 
such as Gantt Chart, and Resource views, such as Resource Usage or Team 
Planner. You can use the View file tab to look at information sorted by date 
or a specific period. You can see the View file tab in Figure 1‐8.

The Format file tab has commands that help you present your schedule, such 
as font styles, page breaks, and column settings. You can see the options in 
Figure 1‐9.

You can either show or hide the Ribbon to produce more real estate on your 
screen. The pushpin to the far right of the Ribbon pins it to your display, 
keeping it open and visible (as shown in Figure 1-10). The upward‐facing 
arrow (^) on the far-right side hides the Ribbon. If your Ribbon is closed, 
click on any tab, look in the lower-right corner of the Ribbon and you will 
see a pushpin. Click on the pushpin to keep your Ribbon open. You can also 
press Ctrl+F1 to show or hide the Ribbon.

Figure 1-8:  
The View 

file tab.

Figure 1-9:  
The Format 

file tab.

Figure 1-7:  
The Project 

file tab.


